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内容

1. Feature Extraction のインストールとライセンス

2. Feature Extraction の機能：イメージ解析

• TIFF イメージの解析

3. スポット数値化のためのセットアップとながれ

4. Feature Extraction の機能：スポット（数値化）

• Non-Agilent アレイのグリッドあわせ

5. Feature Extraction スポット数値化アルゴリズム

6. QCレポート

7. Agilent miRNA解析用マイクロアレイ（参考）

8. ソフトウェアのバージョン・アプリケーションごとの、FEプロトコルの対応表

• スポット検出

• フィーチャ＆バックグランド領域の決定

• シグナル強度の抽出

• バックグランド補正

• Multiplicative Detrending
• 色素補正 （2 color）
• 発現比計算 （2 color）
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Feature Extraction の
インストールとライセンス



FE version 9.5 TR JPN Page 4

インストールについて

システム要件

Administratorの権限でログインをする必要があります
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ライセンスについて

2種類のライセンス

• 通常ライセンス

 1台の PC につき 1ライセンス使用

 PC のホスト ID 情報が必要 （PC は固定）

• 30日間デモ用ライセンス

 Web からダウンロード可能

 サポートはありません



FE version 9.5 TR JPN Page 6

ライセンスキーの取得法

• Agilent ウェブからライセンスキーを取得

https://software.business.agilent.com

あるいは Feature Extraction の Help > Agilent License を選択すると上記ウェブにリンクします

• ライセンスキーの取得には以下のものが必要

 Order Number
Feature Extractionソフトウェア2ライセンス権利証明書 (G2566-60000)に記載

 Certificate Number
Feature Extractionソフトウェア2ライセンス権利証明書 (G2566-60000)に記載

 Host ID
次スライド参照

 メールアドレス
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ホストIDの調べ方

1. Feature Extraction をインストール

2. Help > About Analysis を選択

3. About Analysis ウィンドウ確認

ソフトウェアのバージョン

Host ID 
(MAC/ Ethernet address)
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ライセンスキーの保管

• ライセンスキー： .lic

• ライセンスキーは以下のディレクトリに保存

Program Files¥Agilent¥MicroArray

バックアップとしてライセンスキーは別の場所にも保管してください
（OS の再インストールの際にライセンスキーがなくなる可能性があります）
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Feature Extraction ソフトウェアを使用する

1. イメージファイルを開ける

2. FLEXIm License Finder 
ウィンドウ

Specify the License File 
を選択

3. 以下のディレクトリに保存した
ライセンスキーを選択

インストール後、最初にライセンスキーを認識させる必要があります

Program Files¥Agilent¥MicroArray
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Feature Extraction の機能
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Feature Extraction を使ったアレイ解析

イメージ解析

スポットの数値化

ＱＣレポート
（version 8より）

+
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イメージ解析でできること

• イメージの色やスケールを変更

• イメージのフリップ＆回転（例：縦長→横長）

• ヒストグラム、ラインプロットの作成

• フィーチャとローカルバックグランドのフラグ確認

• マイクロアレイ上のグリッド調整

マイクロアレイのイメージを確認
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スポット数値化でできること（１）

 Place Grid
グリッドの初期化

 Find and Measure Spots
中心位置の決定→フィーチャとローカルバックグランド領域の決定→
ピクセルレベルのフラグ排除→シグナル強度計算

 Flag Outliers
フィーチャとローカルバックグランドのフラグづけ

 Correct Background and Signal Biases
バックグランド補正とシグナルの有意性検定

 Correct Dye Biases
色素バイアス補正のためのフィーチャ選びと補正

 Compute Ratios and Errors
ログ比（Cyanine 5 / Cyanine 3） およびエラー値、P値の計算

各スポット（フィーチャ）のシグナル抽出および発現比計算
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スポット数値化でできること（２）

 QC Report Header
採用したバックグランド／色素補正法、バックグランドノイズ、色素補正係数

 Spot Finding of Four Corners
アレイの四隅のグリッド合わせと決定した中心位置を可視表示

 Number and Spatial Distribution of 
Outliers and Up- / Down- Regulated Features
フラグおよび発現差のあるフィーチャの数、およびこれらのフィーチャのアレイ上で
の分布

 Net Signal Statistics and Local Background Inliers
フィーチャおよびローカルバックグランドのシグナル値の統計

 Foregournd Surface Fit
フォアグランドの見積もり結果（アレイ表面のフィッティング）

 Plot : 赤と緑のバックグランド補正シグナル、M-Aプロット

LogRatioの期待値と実測値.

バックグランド補正シグナルの%CV（スパイクイン）

スポット解析後のＱＣレポート
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Feature Extraction各バージョンでの変更点

1.グリッディング精度向上

2.Agilent遺伝子発現1色法データの数値化可能

3.アプリケーションごとのQCレポート作成

4.Agilent2色法データのAxon画像数値化可能

5.新しいAdditive Detrendingの導入

Option: ネガコンRangeのFeatureを使う

6.新しいデザインファイルをeArrayから入手可能

7.FEのcommand line versionをサポート

1.Agilent高密度マイクロアレイの数値化可能

2.Agilentマイクロアレイのグリッディング精度向上

3.AgilentスキャナのXDRスキャンで得た画像ペア

から数値化可能

4.Agilentマイクロアレイの数値化速度向上

5.1つのFeature Extraction protocolで、

全てのフォーマットの数値化可能

6.Compactのテキストファイル出力可能

7.QC chart toolの導入と、QC metricsのFE内での

使用可能

1.miRNAマイクロアレイの数値化が可能

2.QCレポートがPDFファイル形式に変更

3.マルチプレックスアレイのグリッディング精度向上

4.全てのAgilentに対してグリッドテスティング改善

5.Dye Norm files扱い改善とdye norm Editor改善

6.Agilent optimized QC metric setsの導入

1.データベースエンジンを MSDEから

SQL Expressへ変更

2.Windows installerのアップデートにより、

Windows Server 2003, Windows XP 64-bit,  

Windows Vista、Windows Vista 64-bitで動作

3.Windows Terminal ServicesでのFEの使用を

制限つきでサポート

4.QCレポートの形式を、HTMLとPDFから選択可能

5.FE 9.5.3 の出力数値はFE 9.5.1と同一

FE8.5

FE9.1.3

FE9.5.1

FE9.5.3
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FEプロジェクトの概念 スポット数値化のバッチ処理

FE Project と Extraction Set

プロジェクト
ファイルの
オープン

プロジェクト
のプロパティ
（出力ファイ

ル等）の設定

イメージ
ファイルの

設定

Extraction Set
の確認

（右参照）

プロトコル
の確認・

変更

プロジェクト
の実行

グリッド
テンプレー
トの確認・

変更

プロジェクトの作成から実行まで

(Standard Project)
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Standard プロジェクト vs. On-Time プロジェクト

On-Timeプロジェクト

スキャンをしながらスポット解析
（“On-the-fly”）－スキャンからスポット
解析まで完全自動化

→完全自動化にはバーコード情報が必要

→スキャン開始時にIncoming Imageフォルダ
とResultフォルダを指定するだけ

Standardプロジェクト

スキャンの終了した複数のTIFFイメ
ージ（様々なフォーマット可）を一つ
のプロジェクト内で解析

Laser Laser Laser Laser

Can Review QC 
Report on-the-fly !

時間

Slide 1 Slide 2 Slide 3 Slide 4

Slide 1 Slide 2 Slide 3
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イメージ解析画面←→スポット数値化画面

イメージ画面への
切り替え（３通り）

１．ツールバーのイメー
ジファイルオープンボタ
ンをクリックまたは
File > Open > Image

２．TIFFイメージをワー
クエリアにドラッグ

３．Project Explorerの
Extraction SetのTIFFイメ
ージ
アイコンをダブルクリッ
ク

（FEプロジェクト）

FE Project
および

イメージ解析
を共有
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Feature Extraction
イメージ解析
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クロップモード、Zoom In & Out

クロップモードON →イメージをクロップ時に新しいウィンドウで表示

クロップモードOFF →イメージをクロップ時にその大きさにあわせてウィンドウを拡大

• 拡大 縮小 100%（PCによって異なります）

• View > Zoom

• ショートカット Ctrl + （左ダブルクリック） 拡大
Ctrl + （右ダブルクリック） 縮小
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スケールの変更 （リニア/ログ）

リニア表示

ログ表示

ログ表示にすることにより、アレイの大きさ、バックグランドのむらなどを確認
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シグナル範囲

両チャンネルのシグナル範囲を確認

Set Image Color Display Ranges 内の数値またはスケーリングバーを変更することで、
イメージ表示を変更可能

スケーリングバー
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ラインプロット

水平線 あるいは左ダブルクリック

垂直線 あるいは右ダブルクリック

注意：ダブルクリックでラインプロットを確認する場合、
クロップモードはOFFにします

指定したラインでのシグナル値を確認
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ヒストグラム

選択範囲のピクセルを使い、ヒストグラムを作成

• 選択範囲＝四角 （アレイ全体など）

• 選択範囲＝丸型 （個々のスポットなど）

クロップモードをOFFにする

をクリックし、右クリックドラッグでスポットを範囲を選択

右クリックドラッグでアレイの範囲を選択
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表示カラーの変更

2色

1色
（赤）

1色
（緑）

その他カラー表示の変更
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Tools メニュー

Flip Upper Left to Lower Right
アレイイメージを裏返し、縦横変換

例：Agilentアレイ
DNA裏面からよみとり
横長、バーコード左

例：Agilentアレイ
DNA表面からよみとり
縦長、バーコード下

Preferences…
イメージ解析、グリッド設定、ＦＥプロ
ジェクトなど、様々なユーザー設定が
可能
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Image File Info

• スキャン時の情報

（Date&Time、 Operator、スキャナの状態）

• その他バーコード情報、イメージ情報を確認
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グリッドモードによる
Non-Agilentマイクロアレイの数値化
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Feature Extraction 数値化までのステップ

Agilent アレイ

Non-Agilent アレイ

Feature Extraction
Project 実行グリッド作業

Feature Extraction
Project 実行
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Non-Agilent アレイグリッド作業：言葉の定義

Input ファイル

• Gene List アレイの行列情報及びアノテーション情報が記載
されているリスト
（ユーザー作成、数値化前に既にわかっている情報）

作業

• グリッド アレイ上のスポット中心位置の決定

Output ファイル

• グリッドファイル メイングリッド、サブグリッドの位置情報

• フィーチャファイル 各フィーチャの位置情報とアノテーショ ン情報
（グリッドファイル作成時に自動的に作成される）



FE version 9.5 TR JPN Page 31

Non Agilent アレイの数値化ながれ

1. グリッドファイルの作成
使用するGene Listの選択

2. メイングリッド位置の調整

3. サブグリッド位置の調整

4. スポット位置の調整

5. グリッドファイルの保存

6. Feature Extractor の実行
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グリッドモード解析

• Agilent スキャナでイメージを読み取った non-Agilent マイクロアレイ

を数値化

• スポット位置検出ツールによって、アレイ上のスポット検出および位置を

自動検出

• Gene List の形式（アレイレイアウト、アノテーション情報）

 Agilent グリッドファイル .csv file

 GAL ファイル (GenePix Array Layout) .gal file

 Agilent デザインファイル .xml file

 タブ区切りテキストファイル .txt file

＜注意＞ Agilent スキャナはスライドグラスの裏側からマイクロアレイを読み取ります
以下の向きが一致していることをお確かめ下さい

• 遺伝子リストの並び順

• イメージの読み取り向き
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グリッドの作成

non-Agilentアレイを数値化するにはグリッドおよびフィーチャファイル作成が必要

1. Grid Mode On/Off をクリックしグリッドモードにする

2. Create/Edit Grid 画面で使用する

Gene List のタイプを選択

• Gene List がある場合：

_grid.csv, gal, xml, tab text 
のいずれかを選択

• Gene List がない場合：

No Gene List を選択
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3. 行列情報をもとに、各項目が

Geometry Information 
ウィンドウに自動入力される

• Gene List がある場合はそのフ

ァイルの情報をもとに

• Gene List がない場合はアレイ

イメージから推測

• →どちらの場合もこの画面で数

値の変更は可能

4. Auto Fit または Manual Fit を
クリック

グリッドの作成
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グリッドの調整

Color > Use Log Color Scale あるいは を選択して
イメージをログ表示し、スポットを確認しやすいよう変換

リニア表示 ログ表示
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メイングリッドの調整 Adjust Main Grid

• グリッドの位置調整

Main Grid View

Main Grid Corner View

Grid カーソルを使ってグリッドを移
動し位置を調整

• グリッドの回転

Main Grid Corner View

マウスをアレイの隅にもっていき、
Rotate カーソルでメイングリッドを
回転

Adjust Main Grid

Rotate

Main Grid 
View

Main Grid Corner 
View

Adjust Main Grid をクリック
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サブグリッドの調整 Adjust Sub Grid
 

• サブグリッドの位置調整

 Subgrid View

 Subgrid Corner View

Grid カーソルを使ってグリッドを移
動し位置を調整

• グリッドの角度変更

 Subgrid Corner View

Skew アイコンをクリックし、アレイの
隅にもっていき角度を変更

Adjust SubGrid をクリック
 

Adjust Subgrid Skew Subgrid

Subgrid View

Subgrid Corner 
View

Skew



FE version 9.5 TR JPN Page 38

スポット位置の調整 Adjust Spot

• “＋”がスポットの中心にくるように調整

• をクリックし、Feature Extraction が
どの位置をスポット中心部として認識す

るか確認

• スポットを選び、Grid Adjustment タブ

にある Ignore をチェックし

True を選択

→ このスポットに関して数値化はおこな

われない

Adjust Spot をクリック Adjust Spot
Preview Spot Centroids

Spot View

Preview Spot Centroids

Zoomed Spot 
View
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グリッドファイルの保存

スポットの中心部が正しく認識されたら Save Grid ボタンをクリックして
ファイルをTIFFイメージと同じフォルダに保存

グリッドファイル _grid.csv および フィーチャファイル _feat.csv が保存される

すぐに数値化を行う場合には、Grid Mode On/Off から
グリッドモードを解除し、Feature Extractor を実行
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Tab Text File での Gene List 作成：必要項目

以下のレイアウト、アノテーション情報が必要

• Grid index (または SubGridRow/SubGridCol )

• SpotRow

• SpotCol

• GeneName または Probename (両方いれることも可能)

• Control 情報も入力可能

必須項目

オプション
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コントロール情報

* 数値化され結果に含まれるが、
色素バイアスなどの計算には使用
されない

** 数値化は行われず、結果にも
含まれない

Name 入力コード

Probe
Positive

Negative

Not Probe*

Ignore**

0
1

-1

-20,000

-30,000

Control Type 
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Tab Text File からのグリッド作成

Create/Edit Grid ウィンドウから Tab Text File 
を選択

各項目のタイトルを指定して OK 
をクリック

タイトルを指定
• Gene List の情報をもとにグリッド

を自動で作成

• 後のステップは No Gene List の
時と同様にグリッド位置の調整を行う
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角がブランクになっているアレイのグリッドあわせ

グリッド作成時に
スポットを１つずつ“Ignore” と
指定 （前述）

グリッドファイルをまず作成

フィーチャファイルからブランクスポット
を集め “1 (ignore)” と指定

補足資料

ブランクの数が少ない場合 ブランクの数が多い場合
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具体的な手順1 ブランクの数が多い場合

1. No Gene List を選択してグリッドファイルを作成

注意： ブランクの位置もスポットがあると仮定してグリッドファイルが作成

フィーチャファイルの編集方法

補足資料

in-zone column
in

-z
on

e 
ro

w
in

-z
on

e 
ro

w
1 2 3 4 5 6 7 8 9 …………14

in-zone column
1
2
3
4
5
6
7

1
2
3
4
5
6
7

1 2 3 4 5 6 7 8 9 …………14

ブランクの位置：
in-zone column 8 – 14
in-zone row 6 - 7
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具体的な手順2 ブランクの数が多い場合

2. 作成されたフィーチャファイルを開く

シート左上のブランクのセル(上記図の赤矢印)をクリックして、シート全部を選択

3. メニューバーの Data>Sort をクリック
Sort by “zone” で Ascending (昇順) をチェック
My list has “Header row” にチェック

補足資料
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具体的な手順3 ブランクの数が多い場合

4. メニューバーの Data>Filter>AutoFilter  をクリック

5. “in-zone column” の▼をクリックして、Option を選択
ブランクになっているサブグリッド内の Column 番号を入力

補足資料

in-zone column

in
-z

on
e 

ro
w 1 2 3 4 5 6 7 8 9 …………14

1
2
3
4
5
6
7

Column 8 - 14
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具体的な手順4 ブランクの数が多い場合

6. 同様に “in-zone row” の▼をクリックして、Optionを選択
ブランクになっているサブグリッド内の Row 番号を入力

7. フィルターをかけブランクスポットのみを集めた後、
“user ignore” を 0 → 1 に変更

補足資料

in-zone column

in
-z

on
e 

ro
w 1 2 3 4 5 6 7 8 9 …………14

1
2
3
4
5
6
7 Row 6 - 7
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具体的な手順5 ブランクの数が多い場合

8. メニューバーの Data > Filter > AutoFilter を再度クリック
フィルターを解除後、フィーチャファイルを保存

9. 編集したグリッドファイル、フィーチャファイルを使い Feature
Extractor を実行

User Ignore が 1 になっているスポット は数値化結果には含まれません

補足資料
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Feature Extraction 
数値化のためのセットアップと

結果について
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プロジェクト

• Project
１～１００枚のTIFFイメージの一括
数値化のプロセス（ファイル保存）

Project Properties および
Extraction Set Configuration 
タブ内の設定が必要（後述）

グリッドおよびプロトコル

• Grid Template
デザインファイル（アジレントアレイ）
およびグリッドファイル

• Protocol
数値化の各ステップのアルゴリズム
の詳細設定

プロジェクト、グリッドおよびプロトコル 言葉の説明
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Feature Extraction 数値化に必要なもの

① Agilent スキャナで読み取った TIFF イメージ（クロップの必要なし）

② Grid Template - デザインファイルまたはグリッドおよびフィーチャファイル

Agilent アレイの場合

デザインファイル (.xml)

 カタログアレイキット CD

 Agilent ウェブから随時ダウンロード可能

Non-Agilent アレイの場合

作成したグリッドファイルおよびフィーチャファイル

(_grid.csv, _feat.csv)

③ Protocol - 数値化のためのプロトコル
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グリッドテンプレートおよびプロトコルの変更・追加

ダブルクリックにて確認・変更 ＆ 右クリックで追加

グリッドテンプレート
（インストール済みのデザインファイルや、
他社アレイのデザインファイルを格納）

プロトコル

既存の“プロトコル”のパラメータを
変更して別の名前で保存すること
が出来ます。ダブルクリックしてパ
ラメータを変更後、“Save as・・・”で
保存すると、Protocol Browserに追

加されます。

新プロトコル

Microarray Kits webpage

Feature Extraction
Software webpage

追加

追加

新デザインファイル
（アジレントアレイ）

Agilent
website

新“プロトコル”を追加したり既存のプロト

コルを変更して名前を変えて保存した場
合、対応するデザイン（グリッド）ファイル
をダブルクリックして、“Properties”（右
図）の”Default Protocol”を変更すること

で、新プロトコルとデザインファイルを自
動マッチングできるようになります。
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プロジェクトファイルの作成
(1)File>New>Standard Project を開く（新規作成）

(2) Project Propertiesを設定

(3) Extraction set configurationタブを開いて、ここにtiffをドラッグ

(４)GridおよびProtocolにはバーコード番号を元に自動で読み込
まれた設定が入るが、タブで選択変更可能
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Feature Extraction の主なアウトプットファイル

 TEXT
タブ切テキストフォーマット （Excel やGeneSpringなどで読み込み可能）

 Geneview（miRNAのみ）

miRNA数値化結果（Excel やGeneSpringなどで読み込み可能）

 JPEG
イメージ圧縮ファイル （注意：JPEG ファイルからスポット数値化不可能）

 MAGE
MicroArray Gene Expression Markup Language フォーマット

 Visual Result
TIFFイメージに重ねてフラグ情報等確認できるファイル

 QC Report
１枚のアレイの数値化結果のレポート（統計情報およびプロット）
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MAGE について

 XML言語をベースとして開発

 Rosetta 社の Resolver ソフトウェアに インポート 可能

 マイクロアレイに関する情報の詳細の記述、共有のためにデザインされ
た言語

 マイクロアレイデザイン、製造情報、実験設定、実験操作情報、遺伝子
発現データ、データ解析結果の詳細を記述可能

 ArrayExpress (EBI) , GEO (NCBI) や CIBEX (DDBJ) などの公
的マイクロアレイデータベースで採用されているフォーマット
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プロジェクトファイルのRun （バッチ処理の開始）

(５)Project＞Start Extraction で開始
(６)Extractionが終わったら。 Project Explorerのツリー
ビューのなかから マークのファイルをダブルクリックす
ると画像の画面へ。

Runが終わると、Summary reporterというタブができて、

情報が表示されます。
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Resolver へのファイル転送

FTP 転送ファイル

• MAGE

• TIFF あるいは JPEG 画像

FTP 設定

• Destination

• FTP port

• User name

• Password
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プロジェクト進行の確認

FE Project name_
YYYYMMDDHHMM.rtf
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Visual Results でのフラグ確認

View > Extraction Results

• View Results
• View Outlier Only
• Hide Outer Local BG Ring
• Use Simple Colors

Help > 
Feature Extraction Output 
Quick Reference

• フラグ内容の確認
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Feature Extraction テキスト結果例

設定値

統計値

データ

※Output Package設定で、FullおよびCompactを選択可能
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JPEGに関する注意

JPEG → TIFF と比較して、解像度が低い

JPEG から Feature Extraction （スポット数値化）は実行できない

※TIFF は必ず保存しておく

JPEG TIFF
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データワークフロー

QC Report
Grid
Shape
Text
JPEG
MAGE-ML
GEML

TIFF画像

Feature Extraction
（数値化ソフトウェア）

GeneSpring

Import

FTP
転送

Feature Extraction
アウトプットファイル

Grid Template
Grid File

FE Protocol

Agilentスキャナで読み込んだ
Agilentおよびnon-Agilentマイクロアレイ

GenePixスキャナ*で読み込んだ
Agilentマイクロアレイ

解析ソフトウェア

スポット検出
フィーチャ＆バックグランド領域の決定
シグナル強度の抽出
バックグランド補正
色素補正
発現比計算

*Gene Pix 4000Bスキャナで読み込んだ
TIFF画像に制限
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Feature Extraction 
アルゴリズム



FE version 9.5 TR JPN Page 64

数値化（スポット解析）の流れ

スポット位置の検出

シグナル補正

色素補正

発現比計算

各スポットの位置（中心）を特定

フィーチャ＆ローカルバックグラウンド
領域の決定

フィーチャとローカルバックグランド
の区分け

シグナル強度の抽出 シグナル強度の計算、異常値の排
除・フラグ

バックグラウンド差し引き法の選択

Multiplicative Detrending

コントロールプローブの選択、補正係
数の算出

Cy5/ Cy3 の発現比を計算

1、2カラー共通

2カラーのみ
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Feature Extraction デフォルトのプロトコル

• Agilent システムを使用した際の推奨

 アプリケーションによって設定は異なる
（Gene Expression, CGH, miRNA）

 Gene Expression用（ 1色用、2色用）

• Non-Agilent：アレイ・システムの場合、マイクロアレイの種類やラベル
化等の違いを考慮した設定が必要

Feature Extractionプロトコルファイルのダウンロードサイト

http://www.chem.agilent.com/scripts/generic.asp?lpage=35952&indcol=Y&prodcol=Y
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※各Protocolの詳細は、Protocol Useに記載

現在、Webからダウンロード可能なプロトコル
（2007年4月現在）

Current Protocols – Version 9.5
・Complete set of protocols

Prior Protocols – Version 9.1
・Complete set of protocols
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初期設定を調べるためには？

• Reference Guide 参照 例）遺伝子発現1色法の
プロトコル
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数値化（スポット解析）の流れ

スポット位置の検出

シグナル補正

色素補正

発現比計算

各スポットの位置（中心）を特定

フィーチャ＆ローカルバックグラウンド領
域の決定

フィーチャとローカルバックグランド
の区分け

シグナル強度の抽出 シグナル強度の計算、異常値の排
除・フラグ

コントロールプローブの選択、補正係
数の算出

Cy 5/ Cy3 の発現比を計算

1、2カラー共通

2カラーのみ

バックグラウンド差し引き法の選択

Multiplicative Detrending
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Place Grid グリッドの初期化 （自動）

2. Placement Method（配置方法）：

• Allow Some Distortion (Default)
フィーチャ／サブグリッド間の間隔
および角度変更を許可

• Place And Rotate Only
グリッドの回転位置のみを許可

1. グリッドの呼び出し

グリッドテンプレート
（デザインファイル）
を使い自動認識

注意：FE v8 よりアジレントアレイのグリッ
ドの初期化アルゴリズムが変更になりま
した。ＴＩＦＦイメージをクロップする必要
はありません。アルゴリズムの変更に伴
い、スポット中心位置が微妙に異なる場
合があります（次頁参照）。
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Find and Measure Spots

アルゴリズムの流れ

1.  全てのスポット中心位置の決定

• 明るいスポット
グリッド情報から微調整して
スポット中心位置を決定

• 暗いスポット
グリッド位置情報から中心位置を決定

FE v7.5   FE v8.x
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外れ値を持つピクセル

フィーチャ領域決定 ローカルバックグランド
領域決定

異常ピクセル排除

Find and Measure Spots

アルゴリズムの流れ（続き）
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Whole Spot 法
スポット形状に合わせて
フィーチャ領域を決定

Cookie Cutter 法
スポット中心部から円を描き
フィーチャ領域を決定

Find and Measure Spots

フィーチャとバックグラウンド領域の定義

径の定義
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• グリッド位置からのずれの許容範囲

• 初期設定値： 1.5 (Agilent Oligo Microarray)

• ユーザー設定： 名目径（半径）に乗ずる値を設定

 Dev Limit を小さくする

スポット中心部の可動範囲が狭くなるので、スポットが極端にずれている場

合、スポットが見つけにくくなる

 Dev Limt を大きくする

近接しているスポットあるいはごみを誤認識する可能性がある

X
+ + グリッド情報からの推定したスポット位置

x 実際のスポットシグナルから修正後の中心位置

Dev Limit によるずれの許容範囲

Find and Measure Spots Spot Deviation Limit     
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Find and Measure Spots
フィーチャとローカルバックグランド領域の設定

ローカルバックグランドの半径の自動計算 （True / False で選択）

 True の場合はSelf径を自動計算（デフォルト）

 False の場合は値を入力

Cookie またはWhole Spot を選択

 Cookie Cutter を選択した場合、Cookie Percentage を設定可能

 Exclusion Zone Percentage を設定可能 - 初期設定値： 1.2 (アジレントアレイ) 

名目径をグリッドテンプレート（デザインファイル）
または

グリッド配置アルゴリズムから取得
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Find and Measure Spots  
ローカルバックグラウンドの半径の決定

最小のローカルバックグランド半径値 (Self径、デフォルト) 

( )2 2
x yScan Resolution ( .6 Interspot spacing ) ( .6 Interspot spacing )n n´ ´ + ´

変更可能なローカルバックグランド半径値 (最大n = 4)

( )x y0.6 Scan Resolution Max Interspot spacing , Interspot spacingé ù´ ´ ë û

• スポットからどれぐらいの範囲を直径とするか n で決定

• ユーザー設定可能な n ： 1～4

• n = 1 であれば、8のスポットを含む近傍エリアから半径を計算

• n = 2 であれば、24のスポットを含む近傍エリアから半径を計算

• n = 3であれば、 48のスポットを含む近傍エリアから半径を計算

• n = 4 であれば、80のスポットを含む近傍エリアから半径を計算

24 nearest 
neighbors 

(n = 2)
2

Self
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Find and Measure Spots

異常ピクセルの排除法の設定

ピクセル排除基準の設定

異常ピクセルの排除法

IQR法

SD法デフォルト：IQR法
(RejectIQRFeat/BG=1.42)
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異常ピクセル排除とフラグの違い（概念）

異常ピクセル排除

フィーチャとローカルバックグランドのフラグ

Find and 
Measure Spots

Flag Outliers（後述）
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Find and Measure Spots 異常ピクセルの排除

標準偏差 (SD) 法

• フィーチャとローカルバックグランド領域
内の異常ピクセルを排除

• 両チャンネル（赤、緑）で確認

• 標準偏差SD±2 の範囲であれば、
~ 95%の分布を含む
→ SD±2範囲外のピクセルは異常ピク
セルとして排除

• シグナル強度は、SD±2 以内のピクセ
ルを平均して計算
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Find and Measure Spots 異常ピクセルの排除

四分位間範囲 (IQR) 法

• 異常ピクセル排除方法

Pixel Intensity > UpperRB
Pixel Intensity < LowerRB

75Upper percentile PixelOutlierRB I Cutoff= +
25Lower percentile PixelOutlierRB I Cutoff= -

75 25

1.42
where 

PixelOutlier

th th

Cutoff IQR
IQR Intensity Intensity

= ´
= -

• IQR x 1.42 の範囲外を異常ピクセル
として排除

• 正規分布の場合、99％が範囲内にお
さまる

四分位間範囲 (IQR) : シグナル強度分布の25-75%間の範囲

外れピクセル 外れピクセル
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XDR (Extended Dynamic Range)スキャン

PMT:10

High

1枚のスライドガラスから、蛍光シグナルの増幅係数の異なる

2枚のイメージが得られる

FE9.1以降は、この２つのイメージを

自動的に統合し、1つの結果を出力する

High Low

QC QC QC QC

text text text text

PMT:100

①スキャナー

②数値化ソフトウェア

US4510XXXX_2514850XXXXX_S01_H.tif US4510XXXX_2514850XXXXX_S01_L.tif
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XDRスキャンイメージの統合

Step 1. 2枚のイメージについて、それぞれNetシグナル強度を抽出

Step 2. 『Low』イメージのNetシグナル強度を
スケールアップするため の、係数・切片を計算

「High」イメージにおいて、Netシグナル強度が
300から20000の範囲にあるフィーチャーが
算出に用いられる

Step 3. 2枚の結果を統合して1つのシグナル値を出力
Highイメージの20000以上のシグナル
強度を持つフィーチャーにおいて、
Netシグナル値が『Low』イメージ
由来のスケールアップ後の値に
置き換えられる

『Low』イメージのシグナル強度

『High

』イ
メ
ー
ジ
の
シ
グ
ナ
ル
強
度

Netシグナル＝ピクセルの平均シグナル強度－スキャナーオフセット（＝アレイ上の最低シグナル強度）
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数値化（スポット解析）の流れ

スポット位置の検出

シグナル補正

色素補正

発現比計算

各スポットの位置（中心）を特定

フィーチャ＆ローカルバックグラウンド領
域の決定

フィーチャとローカルバックグランド
の区分け

シグナル強度の抽出 シグナル強度の計算、異常値の排
除・フラグ

コントロールプローブの選択、補正係
数の算出

Cy 5/ Cy3 の発現比を計算

1、2カラー共通

2カラーのみ

バックグラウンド差し引き法の選択

Multiplicative Detrending
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異常ピクセル排除とフラグの違い（概念）

異常ピクセル排除

フィーチャとローカルバックグランドのフラグ

Find and 
Measure Spots

Flag Outliers
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Flag Outliers OutLier（フラグ）の種類

Saturation

Non-Uniformity
Green

Red

Population OL
Feature

※Feature内ピクセルの50%以上saturationした場合

Green

Red

Green

Red

Green

Red

Green

Red

Feature

LocalBackGround

LocalBackGround
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Flag Outliers アルゴリズム

フラグ自動認識プログラム

Non-Uniform Outliers

・各フィーチャ、ローカルBGについて

構成ピクセルの均一性をチェック

・アレイ製造、ラベリング、スキャナ

ノイズ等を考慮した多項式分散

モデルにより OutLier を判定

Population Outliers

・繰り返しスポットされたフィーチャ

及びローカルBGについて、集団として

の均一性をチェック

・ 初期設定 の集団の数は 10

・ IQRまたはQ-test により

Outlier を判定
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Flag Outliers NonUniformity Outlier

x :  (フィーチャまたはバックグランドのMean Signal) –
(フィーチャまたはバックグランドのMin Signal)

A (Gaussian) – ラベリング及びフィーチャ合成反応から見積
もられた分散

B (Poisson) – スキャン測定またはカウントエラーから見積
もられた分散

C (Constant) – スキャナの電気的ノイズ及びスライドグ
ラスのバックグランドノイズから見積もられた分散

2 2
E Ax Bx Cs = + +

2

2

Array

PixSDevA CV
MeanSignal MinSig

æ ö
= = ç ÷ç ÷-è ø

1
2 2

0

1 ( )
1

n

M i
i

X X
n

s
-

=

= ´ -
- å

n = フィーチャ または バックグランド のInlierピクセルの数

X = フィーチャ または バックグランド のピクセルのシグナル強度

X bar = フィーチャ または バックグランド のシグナルの平均値

( )2 2
M E CIs s> + 実測値分散が予測値分散よりも大きい場合にフラグ

CI はカイ2乗分布から計算された信頼区間

Expected Variance（予測値） Measured Variance（実測値）

NonUniformity Outlier の判定基準
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Flag Outliers  Population Outlier

PopulationOutlierの適用対象

・1x22Kおよび1x44K、あるいはFeature Extraction9.1の場合

→繰り返しスポット数：10スポット以上、 Outlierの認識法：IQR

・4x44K、8x15Kおよび1x244K(Feature Extraction9.5)の場合
- 繰り返しスポット数：11スポット以上、 Outlierの認識法：IQR
- 繰り返しスポット数：3~10スポット、Outlierの認識法：Q-test
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Flag Outliers  Population Outlier

75 25

1.42
where 

PixelOutlier

th th

Cutoff IQR
IQR Intensity Intensity

= ´

= -

1,42*IQRを使用した場合、 99 %以

上の

分布が排除限界の内側に含まれる。

MeanSignal > UpperRB
MeanSignal < LowerRB

75Upper percentile PopOutlierRB I Cutoff= +
25Lower percentile PopOutlierRB I Cutoff= -

Population outlier の判定基準
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Qexp > Qcritical ,then FeatPopOutlier = 1 

Qexp = |Xi-Xnearest| / |Xmax – Xmin|

Xi : あるプローブのシグナル強度

Xnearest : Xiに一番近いシグナル強度

繰り返しスポット数 Qcritical
3 0.970
4 0.829
5 0.710
6 0.625
7 0.568
8 0.526
9 0.493
10 0.466

95% Confidence level

Q-test 

Flag Outliers  Population Outlier
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Flag Outliers 画面上での OutLier の確認

ログスケール

リニアスケール

フィーチャの内側の
ピンクのリング
= Feature non-uniformity

フィーチャの外側の緑のリング
= BG non-uniformity

フィーチャの外側の青緑のリング
= BG Pop-OL
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Compute Bkgd, Biases and Error
アルゴリズムの流れ

１．選択された Background Subtraction を実施

２．Spatial detrend を実施 （Trueの場合）

３．Error値の計算

（伝播エラーモデルとユニバーサルエラーモデルのいずれかを使用）

４．有意差検定を実施

（Significance testとWell above BG)

５．Surrogate値の計算

６．Multiplicative Detrending

オプション

オプション
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Compute Bkgd, Biases and Error
バックグランド補正について

アレイ

アレイ表面がもつ蛍光は Local BG で引き算

各スポットがもつ蛍光はアレイ全体で均一として
Global Adjustment で補正

FE 7.1 までの BG 補正方法 （初期設定）

アレイ

各スポットがもつ蛍光( Foreground シグナル）を
スポットごとに見積もり、バックグランドとして
差し引く (Detrending）

FE 7.5 から追加された BG 補正方法 （初期設定）

ローカルBG ＋ 核酸蛍光（Global Adj） 一定値

Detrend で計算された Foreground 
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Compute Bkgd, Biases and Error
１．Background Subtraction

No Background Subtraction (初期設定)

• フィーチャのシグナルから ローカルBackground のシグナルを

差し引かない

• フィーチャの生シグナル値 （MeanSignal） を次のステップの Spatial
Detrend に使用 （Trueの場合）

• No Background Subtraction を選択した場合、Global Adjustment
は行わない （初期設定）
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Compute Bkgd, Biases and Error
2. Spatial Detrend の流れ

１．アレイ上でウィンドウをスキャン
させ、ウィンドウ内で、一定の
低いシグナル強度範囲に
あるフィーチャを検出

S c a t t e r  P l o t

C o l
0 2 5 5 0 7 5 1 0 0 1 2 5 1 5 0 1 7 5 2 0 0

1 0 0

8 0

6 0

4 0

2 0

0

2．検出されたフィーチャから Foreground
シグナルの見積もりに使用する
フィーチャを決定
（CGH・ChIP on chipではネガコンを使用）

3．得られた Foreground シグナルの
分布を 2D-LOESS アルゴリズム

を用いてフィッティング

4．全フィーチャに対して各々の Foreground
シグナルを算出し、Meanシグナルから
差し引く
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Compute Bkgd, Biases and Error
2. Spatial Detrending

ウィンドウの移動
各ウィンドウごとに一定のシグナル範囲にあるフィーチャを検出

Window = 10, Increment = 5
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Compute Bkgd, Biases and Error
2. Spatial Detrending

ウィンドウ移動により選択されたフィーチャセットと Foregroundシグナルの
強度分布（拡大図）

Scatter Plot

Col
0 25 50 75 100 125 150 175 200

100

80

60

40

20

0

Features from Low Pass Filter – Raw Green Intensities
gMeanSignal
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2D Loess FitFiltered set

Compute Bkgd, Biases and Error
2. Spatial Detrending
2D Loess フィット
全てのフィーチャに対する Foreground シグナル値の算出 （拡大図）

gMeanSignal gSpatialDetrendSurfaceValue
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Compute Bkgd, Biases and Error
2.AgilentアレイのSpatial Detrending

Fitted Smoothed meanSignal ( ~60 - ~85 counts)

スムージング後のシグナル強度
(all features)
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Compute Bkgd, Biases and Error
2.Agilent アレイのSpatial Detrending

Spre ad  o f N eg ative  Co ntro ls  ( ~50 - ~90 counts)

スムージング後シグナル強度

+3 Residuals

- 3 Residuals

2

1

( )
N

i i
i

I O

N
=

-åResidual ＝

I = Expected Fit Value
O = Observed Fit Value 

残差分析を行い、外れ値を除く
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Sp atial  (Ad d i tive ) De tre nd  Surface

スムージング後シグナル強度

Spatial Detrend Surface
(All features)

Compute Bkgd, Biases and Error
2.Agilent アレイのSpatial Detrending

外れ値を除き、再度、スムージングを行う
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Compute Bkgd, Biases and Error
2.Spatial Detrendを使用した時の出力項目

FEATURES table (2 項目):

[r,g]SpatialDetrendIsInFilteredSet – 0 または 1

• 1 = foreground シグナルの算出のために選択されたフィーチャ

• フラグ（FeatNonUnifOLs, BGNonUnifOLs）・サチュレーション・

Pro25G コントロールフィーチャは foreground シグナル算出に

使用しない

[r,g]SpatialDetrendSurfaceValue

• 各フィーチャの foreground シグナルの値

（LOESSを用いた surface fit によって決定）

詳細はテキストアウトプットを参照
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Compute Bkgd, Biases and Error
2.BGSubSignal 計算方法まとめ

BGSubSignal = MeanSignal – BGUsed
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エラーモデル

Log Ratio のエラーを見積もるための３つのエラーモデル

• ピクセルレベルの統計に基づく伝播エラーモデル
（Agilent’s propagated error method based on pixel-level statistics）

• ロゼッタ社のユニバーサルエラーモデル
（Rosetta’s Universal Error Model: UEM)

• 伝播エラーモデルとUEMから導かれるエラーのうち、
より大きな値を採用するモデル（デフォルト）

採用するエラーモデルに応じて、 Log Ratio = 0 の可能性（P値）を計算

Compute Bkgd, Biases and Error
３．エラー値の計算
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Compute Bkgd, Biases and Error
３．エラー値の計算

伝播エラーモデル

 各アルゴリズム（例：シグナル抽出、バ

ックグランド補正等）のステップで生じる

ピクセルレベルの誤差の伝播に基き

Log Ratio の誤差（エラー）を算出

 シグナルの低い領域において有効

 シグナルが中程度およびより高い領域

において過小評価

誤差の伝播

PixStDev

スポット位置の検出

バックグラウンド補正

色素補正

発現比計算

フィーチャ＆バックグラウンド領域の決定

シグナル強度の抽出
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Compute Bkgd, Biases and Error
３．エラー値の計算

伝播エラーモデルとユニバーサルエラーモデルのうち
エラーの大きい方を使用（Conservative：推奨）

両方のエラーモデルを評価し、より大きな（より保守的な）P値をレポート

mRNA量

シ
グ

ナ
ル

強
度

バックグランド
ノイズ（Additive）

強度依存に基づくノイズ
（Multiplicative）

ユニバーサルエラーモデル

Additive および multiplicative エラー項を
用いて赤および緑チャネルで期待されるエラー
を算出

•Additive
一定量のノイズエラー
（低シグナル領域で優先）

•Multiplicative
シグナル強度依存の変動に基づくエラー
（高シグナル領域で優先）

シグナルが中程度およびより高い領域において有効ノ
イズのあるフィーチャ、特にシグナルの低い領域におい

て過小評価
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Compute Bkgd, Biases and Error
4.フィーチャシグナルの有意差検定
Feature Significance Test

BGシグナルもしくはエラーの値に対し、
フィーチャシグナルがsignificantである
かどうかを判定:

計算されたp-valueがユーザーが設定した
p-valuemaxより小さい場合は、FE出力の
IsPositiveAndSignif の項目で 1 を出力

Well Above Background Test

BGSubシグナルが、下式で計算され
たバックグランド値よりも “well above”
であるかどうかを判定:

IsPositiveAndSignif testとWellAboveの両
方をパスしたフィーチャに対して, FE出力の
IsWellAboveBG column の項目で１を出力

Calculated MaxpValue pValue<
BGSubSignal WellAboveSDMulti BGSDUsed> ´

フィーチャ

BG

2-sided Student’s t-test

※Agilent高密度フォーマットアレイ
では、t-testにローカルBGの分散で

はなくError値を使用
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Compute Bkgd, Biases and Error
5.Surrogate値の計算

-発現量が少なく、生物学的意味のないシグナル強度を示している値

-小さすぎて、その後の計算に支障をきたす値

具体的には、これまでの過程を経たシグナルが、下記のいずれかに該当する場合…
• BGSubSignal が IsPosAndSignif の判定ではねられる（Failする）場合

• BGSubSignal が バックグランドの標準偏差 (i.e. BGSDUsed) よりも小さい場合

サロゲート値（バックグラウンドレベルの値）に置き換える

サロゲート値： バックグランドシグナル強度の１SD（ x DyeNormFactor（2色のみ））

（前ステップの有意差検定に使用した方法によって、値は異なる）

• ローカルバックグランド法 ピクセルレベルのローカルバックグランドの SD 

• グローバルバックグランド法 アレイ上の集団（population）レベルの SD 

• Error Model法 （Additive Error値/2.6）×P値

Surrogate:
代理、代わ
りのものSurrogateとは・・・
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Compute Bkgd, Biases and Error
5.Surrogate値の計算

サロゲート値が適用された場合、FEアウトプットテ
キストファイルの『Surrogate Used』にサロゲート値
が表示される

（適用されなければ０）

1色法 2色法

エラー値の計算 エラー値の計算

有意差検定

Surrogate値の計算

Surrogate値の適用

有意差検定

Surrogate値の計算

Surrogate値の適用

色素補正係数の計算と適用

FE output で
確認可能

※2色法では、色素補正後に
Surrogate値が適用される
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Compute Bkgd, Biases and Error
6. Multiplicative Detrending – Finding the Trend

Lo o k  F o r T re nd s  b y F i tti ng  T he  B G S ub S ig na l

1枚のアレイ内で、

各エリアでのシグナル強度の傾向（Trend）を見つけることで、

アレイ全体のシグナル強度を補正
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Compute Bkgd, Biases and Error
6.Multiplicative Detrending

E ffe c t o f D e tre nd ing

MovAvgCol

2.509

2.518

2.528

2.537

2.547

2.557

2.566

2.576

2.586

2.595

2.605

1.64
1.606

1.675
1.646

1.71
1.686

1.746
1.725

1.78
1.766

1.82
1.805

1.85
1.845

1.89
1.885

1.924
1.925

1.96
1.965

1.995
2.005

0 5 10 15 20 25 30 35 40 45

Surface Trend

BGSubSignal

ProcessedSignal
エリアにおけるシグナル強度傾向

実際のシグナル強度

補正したシグナル強度
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レプリケート（繰り返し）プローブのCV値を指標に
Multiplicative DetrendingのOn/Offを自動で決定
→Offの場合、WARNINGが出現

•MD前のCV値が、MD後のCV値よりも大 → MDがOn
•MD前のCV値が、MD後のCV値よりも小 → MDがOff

Compute Bkgd, Biases and Error
6. Multiplicative Detrending - WARNING
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数値化（スポット解析）の流れ

スポット位置の検出

シグナル補正

色素補正

発現比計算

各スポットの位置（中心）を特定

フィーチャ＆バックグラウンド領域の決定 フィーチャとバックグランドの区分け

シグナル強度の抽出 シグナル強度の計算、異常値の排
除・フラグ

コントロールプローブの選択、補正係
数の算出

Cy 5/ Cy3 の発現比を計算

1、2カラー共通

2カラーのみ

バックグラウンド差し引き法の選択

Multiplicative Detrending
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Correct Dye Biases
色素バイアスの概念

in
te

ns
ity

Gene ID

TTTTTT

TTTTTT

色素バイアスの要因（例）

- ２サンプル間のRNA量が不揃い

- ２つの色素のラベリング効率の相違

- スキャン時のレーザーパワーの違い

gBGSubSignal

rB
G

Su
bS

ig
na

l
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Correct Dye Biases アルゴリズム

色素バイアス補正のアルゴリズム：

1. 補正係数の計算に用いるフィーチャの選択

• Rank Consistency Filter

• Use All Probes

• Use List of Normalization Genes

• Use Rank Consistent List of Normalization Genes

2. 補正係数（normalization factor）の計算

• Linear 

• Linear&LOWESS

• LOWESS

１．パーセンタイルの閾値

２．このオプションを選択すると、
BGPopnOL も考慮される（デフォ
ルトはFalse)。

３．このオプションを選択すると、
コントロールプローブも考慮され
る（デフォルトはFalse)。

４．バックグランドと比べて有意ま
たは有意でないと判断されたプロ
ーブセットを考慮するかどうかを
選択可能（デフォルトは
PosAndSignifプローブのみを使
用）。

1
2
3
4
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Correct Dye Biases
補正係数の計算に用いるフィーチャの選択
Use Rank Consistent Probes （デフォルト）

• 赤チャネルと緑チャネル間で “Central Tendency Line （中心線）”
に沿って位置するフィーチャを使用

 リアルタイムに ハウスキーピング遺伝子を選択するような作業。

Use All Probes
• コントロールでなく、且つ異常値を持たないフィーチャを使用

Non-control  ControlType = 0
Non-outlier  両チャネルで IsFeatNonUnifOL, IsFeatNonPopnOL 且つ 飽和し

ていない

Use List of Normalization Genes
• ハウスキーピング遺伝子あるいは発現差が無いと考えられる遺伝子

を使用（ユーザーが定義:外部ファイルを使用可）

Use Rank Consistent List of Normalization Genes
• 定義する遺伝子リストに対し、Rank Consistency Filterを適用
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7

6

5

4

3

2

1

フィーチャ
番号

77007423

2149345

3300243

64526360

1146499

43905170

5560130

ランク（緑）
rG

緑チャネル
強度
IG

ランク（赤）
r R

赤チャネル
強度
IR

R

G

Correct Dye Biases
Rank Consistency Filter
中心線に沿ったフィーチャの同定

各フィーチャのシグナル強度をチャネル毎にランク付けから計算。

各フィーチャのチャネル別ランクに基づく中心傾向 = |rR - rG |/S(Features) £ t
（ t: パーセンタイル閾値）

両チャネルのランクをフィーチャ毎に比較し、 t パーセンタイル以内に入るフィーチャを同定

赤と緑で
似通ったラ
ンクである
フィーチャ
は、．．

例:中心傾向５パーセンタイル（t =0.05）以内に入っているフィーチャ
中心傾向１５パーセンタイル（t =0.15）以内に入っているフィーチャ

フィーチャ選択のための付加的なフィルタ:

1. Not Saturated

2. Non Population Outlier

3. Non Non-Uniformity Outlier
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Correct Dye Biases
Rank Consistency Filter により選択されたフィーチャ（青色）

中心線
（Central Tendency Line）

Self vs. self hybridization
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Correct Dye Biases 補正係数の決定 Linear

色素バイアスはシグナル強度に関わらず一定と仮定（グローバル）

平均の log ratio はゼロ

赤と緑の各チャネルで補正係数（LinearDyeNormFactor）を決定

補正係数の決定の為に選択されたフィーチャの幾何平均が 1,000 となる様に係数を計算

例： 幾何平均が 250 の場合、LinearDyeNormFactor = 4

リニア法の問題点 色素バイアスがシグナル強度依存的な場合は不適切

Linear ノーマライゼーション法
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Correct Dye Biases 補正係数の決定 LOWESS

LOWESS : locally weighted linear regression 
（局所重み付け直線回帰）

色素バイアスはシグナル強度依存的と仮定

赤と緑の各チャネルで各フィーチャに対し、強度依存的な補正係数
（LOWESS または Linear&LOWESS DyeNormFactor）を決定

補正係数の決定の為に選択されたフィーチャ（ノーマライゼーションセット）に対し、
局所重み付けの直線回帰によるフィッティングを実施

LOWESS ノーマライゼーション法
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Correct Dye Biases
DyeNormFactor (DNF) の計算

& DyeNormSignalLinear LOWESSDyeNormFactor
BGSubSignal LinearDyeNormFactor

=
´

DyeNormSignalLOWESSDyeNormFactor
BGSubSignal

=

10
1

1 log

1000

10

n

i
i

BGSubSignal
n

LinearDyeNormFactor
=

æ ö
ç ÷ç ÷
è ø

=
å

n はノーマライゼーションセットにおける
フィーチャの数 (i.e. IsNormalization = 1 
のフィーチャ)

FE output で
確認可能

Linear 法

Linear&LOWESS 法: （アジレントアレイのデフォルト）

LOWESS 法
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X

Y

Linear フィッティング:   y = Slope (傾き) *x + Intercept (切片) + scatter

y = m*x + c + e

Linearフィッティングにおける仮定:
1. Scatter is Gaussian about a Mean = 0
2. Standard Deviation of scatter about a point on the curve is 

independent of the x-variable.

Correct Dye Biases
Linear vs. Non-Linear フィッティング

（独立変数）

（
従

属
変

数
）

1次式での当てはめ
→線形近似（i.e. Linear）

青：Linear フィッティング
赤：Non-Linear (LOWESS) フィッティング
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X

Y

Correct Dye Biases LOWESS

X

X X
X X

X

Window の移動

Window毎に直線近似
→中心点を連結

Locally Weighted Linear Regression （局所重み付け直線回帰）
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X

Y
X

Y

より滑らかな
フィッティング

Correct Dye Biases LOWESSフィッティングの細分化
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Correct Dye Biases
DyeNormSignal の計算

赤・緑チャンネル、フィーチャ毎に色素補正後のシグナル強度を計算

 if Linear method is used

&  if Linear&LOWESS method is used

 if LOWESS method is used

where

DNF LinearDyeNormFactor

DNF Linear LOWESSDyeNormFactor

DNF LOWESSDyeNormFactor

DyeNormSignal BGSubSignal DNF

=

=

=

= ´
この時

（リニア法）

（リニア＆LOWESS法）

（LOWESS法）

いずれかの DyeNormFactor （DNF）を適用
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数値化（スポット解析）の流れ

スポット位置の検出

バックグラウンド補正

色素補正

発現比計算

各スポットの位置（中心）を特定

フィーチャ＆バックグラウンド領域の決定 フィーチャとバックグランドの区分け

シグナル強度の抽出 シグナル強度の計算、異常値の排
除・フラグ

コントロールプローブの選択、補正係
数の算出

Cy 5/ Cy3 の発現比を計算

1、2カラー共通

2カラーのみ

バックグラウンド差し引き法の選択

Multiplicative Detrending
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Compute Ratios 
発現比の計算の流れ

MeanSig

BGSubSig

DyNormSig

ProcessedSig

バックグランド補正

色素補正

サロゲート補正

Ratio 計算

Log(rProcessedSignal/gProcessedSignal)

エラーモデルで
Log Ratio の有意性を計算

• Log Ratio Error （誤差）

• P-value （P値）

シグナルがバックグランド付近の場合、例
えば DyeNormSignal がマイナスになって
しまい、Log ratio が計算できない。このよ
うな場合、色素補正後のシグナル値に対

しサロゲート値を適用する。
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Compute Ratios 
P値および Log Ratio エラーの計算

1
2 2

xDev xDev
pvalue Erf Erfc

æ ö æ ö
= - =ç ÷ ç ÷

è ø è ø

式 1

ユニバーサルエラーモデルの場合
xDev から LogRatioError を計算

伝播エラーモデルの場合
LogRatioError から xDev を計算

Erf: 確率密度関数
正規分布 N (0, ½) の2倍

P値は帰無仮説（LogRatio=0）
が誤って棄却され得る統計的
可能性

LogRatioxDev
LogRatioError

=

式 2

xDev: LogRatio=0からの偏差に相当。S/Nパラメータに類似。
FE output のFEATURES テーブルに記載。
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Compute Ratios 
エラーモデルのデフォルト設定変更

Additive エラーの自動見積もり（Agilentアレイのデフォルト） : 

• ユニバーサルエラーにおける Additive エラー項を、Spatial Detrend Surface （遺伝子発現）
またはNegative Control（CGH, CoC)の変動に基づいて動的に算出

• Additive エラーの自動見積もりを行う際は、バックグランド補正の中でSpatial Detrendを実施
する事を推奨
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Calculate Metrics
QCレポートパラメータの設定

３つのパラメータを変更
可能 :

• SpikeIn Target Used

• Min Population for 
Replicates

• PValue for Differential 
Expression
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Generate Results
出力ファイル形式の設定

２つのパラメータを変更
可能 :

• Generate Single Text File

• JPEG Down Sampling 
Factor
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QCレポート

数値化ソフトウェア Feature Extraction 8.1 以降の機能
自動ＱＣレポート出力

QCレポートの詳細は、

Help > Reference Guideを選択

Refernce Guide内のQC Report Resultsに記載

※日本語版ドキュメントも準備しております。
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数値化（スポット解析）の流れ

スポット位置の検出

バックグランド補正

繰り返しプローブの統合

各スポットの位置（中心）を特定

フィーチャ＆バックグランド領域の決定 フィーチャとバックグランドの区分け

シグナル強度の抽出 シグナル強度の計算、異常値の排
除・フラグ

Gene View Fileの出力 miRNA

参考：miRNAの数値化

miRNAの数値化では、

繰り返しプローブ・

配列は異なるが同一miRNAに

対応する複数のプローブを

統合し、TotalGeneSignalを出力
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GeneViewファイルの作成
参考：miRNAの数値化

SystematicName プローブがハイブリするよう設計されたターゲット配列のID

フィーチャーのコントロールタイプ

　　　０　　　コントロール以外のプローブ

　　　１　　　ポジティブコントロール

　　　‐１　　ネガティブコントロール

gTotalGeneSignal 各miRNAについて計算されたシグナル値

gTotalGeneError シグナル強度のエラー値

シグナル値がエラー値よりも十分高く検出されているか

　　１　シグナル値がエラー値の3倍以上である

　　０　シグナル値がエラー値の3倍より低い

ControlType

gIsGeneDetected

miRNA FE protocolでは、タブ区切りテ
キストファイル・MAGE-MLファイル・QC
レポートなどに加え、GeneViewという
名前のタブ区切りテキストファイルを
出力します。
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TotalGeneSignalの計算法

-複数のProbe配列/miRNA
-複数の繰り返しFeature/Probe配列

Probe A
Probe B

+ + + + + + + + )( / 9[ ] *10*(#pixels/feature)=TotalProbeSignal (Probe A)

*10*(#pixels/feature)=TotalProbeSignal (Probe B)+ + + + + + + )( / 8[ ]

TotalProbeSignal (Probe A)+TotalProbeSignal (Probe B)=TotalGeneSignal

X Outlier

Step 1 –Population Outlierを除外

Step 2 –ProbeごとのNon-Outlier Featureの
シグナル強度を平均する

Step 4 – それぞれのmiRNAに対応する全て
のProbeのTotalProbeSignalを合
計する＝TotalGeneSignal

Step 3 –上の平均値に、このProbeに対応す
るPixelの数と補正係数をかける
＝TotalProbeSignal

参考：miRNAの数値化
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Feature ExtractionでのTotalGeneSignalの計算法例
例）１miRNAに対して2種類の配列 →それぞれの配列が10回繰り返し

miRNAの種類Probeの種類 各Probeの

Signal強度

Pop Outlier

フラグ

Total Probe 

Signal

Total Gene 

Signal

参考：miRNAの数値化
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Feature ExtractionでのTotalGeneSignalの計算法例

1.繰り返しプローブのうち、

Population Outlierフラグの

立っているものを除外する

2.残りの繰り返しプローブの

Processed Signalの平均値

を出す

②残り9プ

ローブの平均
値を算出

①PopOL
は除外

参考：miRNAの数値化
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Feature ExtractionでのTotalGeneSignalの計算法例
3.EffectiveFeatureSizeFraction

（スポットの中の、シグナル抽出計算

に用いられたエリアの割合）を算出

※値はTextOutputFileのStatsに報
告されます（左図参照）

4.スポットの面積値を算出

※8x15kの場合は

面積値＝（スポット半径＝32.5）の２乗×3.14

5. 以下の式で、TotalProbeSignalを算出する

TotalProbeSignal=

PopOLフラグの立っていないプローブの平均シグナル強度

×繰り返しプローブ数

×Effective Feature Fraction

×スポット面積値

×1/30000

参考：miRNAの数値化
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Feature ExtractionでのTotalGeneSignalの計算法例

6.それぞれのProbeについてTotalProbeSignalを算出し、同じ

miRNAに対応するTotalProbeSignalを合計する＝TotalGeneSignal

参考：miRNAの数値化
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-AgilentNon-AgilentGE2-NonAT_95_Feb07

遺伝子発現

（2色法）

Mammalian Chip-on-Chip

(P/N G4481-90010)

Agilent, 

GenePix

4x44K, 

2x105K, 244K
ChIP-v1_95_May07Chip-on-Chip

アレイCGH

Tecan HS Pro Hybridizationを使う場合

(P/N G4410-90011)

Agilent, 

GenePix
2x105K, 244KCGH-4_95_Tecan_Feb07

microRNA v1.0

(P/N G4170-90010)
Agilent8x15KmiRNA-v1_95_May07

2色法遺伝子発現 v3.0.x 

(SSPEまたはSSC洗浄)

(P/N G4140-90050または

G4140-90030)

Agilent, 

GenePix
2x11K, 22K, 44KGE2-SSPE_95_Feb07

2色法遺伝子発現 v4.0.x

(P/N G140-90050)

Agilent, 

GenePix
2x11K, 22K, 44KGE2-v4_95_Feb07

2色法遺伝子発現 v5.0.xあるいはv5.5.x

（高密度フォーマット対応）

(P/N G4140-90050)

Agilent, 

GenePix

8x15K,4x44K, 

2x105K, 244K
GE2-v5_95_Feb07

microRNA

1色法遺伝子発現 v1.0.x

(P/N G4140-90040)

Agilent, 

GenePix
2x11K, 22K, 44KGE1-v1_95_Feb07

1色法遺伝子発現 v5.0.xあるいはv5.5.x

（高密度フォーマット対応）

(P/N G4140-90040)

Agilent, 

GenePix

8x15K,4x44K,

2x105K, 244K
GE1-v5_95_Feb07

遺伝子発現

（1色法）

アレイCGH v4.0

(Publication Number G4140-90010)

Agilent,

GenePix

2x11K, 22K, 44K, 

8x15K, 4x44K, 

2x105K, 244K

CGH-4_95_Feb07

CGH

実験プロトコルスキャナ

Agilent

アレイ

フォーマット

FE Protocolアプリケーション

Protocols for Feature Extraction 9.5
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Protocols for Feature Extraction 9.1

-AgilentNon-AgilentGE2-
NonAT_91_0806

(P/N G4140-90050またはG4140-90030)

2色法遺伝子発現 v3.0.x 
(SSPEまたはSSC洗浄)Agilent, GenePix2x11K, 22K, 

44KGE2-SSPE_91

(P/N G140-90050)

2色法遺伝子発現 v4.0.x
Agilent, GenePix2x11K, 22K, 

44KGE2-v4_91

(P/N G4140-90050)

2色法遺伝子発現 v5.0.x
（高密度フォーマット対応）Agilent, GenePix4x44K, 

2x105K, 244KGE2-v5_91_0806

遺伝子発現（2色法）

(P/N G4140-90040)

1色法遺伝子発現 v1.0.x
Agilent, GenePix2x11K, 22K, 

44KGE1-v1_91

(P/N G4140-90040)

1色法遺伝子発現 v5.0.x
（高密度フォーマット対応）Agilent, GenePix4x44K, 

2x105K, 244KGE1-v5_91_0806

遺伝子発現（1色法）

(P/N G4140-90010)

アレイCGH v4.0
Agilent, GenePix

2x11K, 22K, 
44K, 2x105K, 
244K

CGH-v4_91CGH

実験プロトコルスキャナ

Agilent
アレイ

フォーマット

FE Protocolアプリケーション

-AgilentNon-AgilentGE2-
NonAT_91_0806

(P/N G4140-90050またはG4140-90030)

2色法遺伝子発現 v3.0.x 
(SSPEまたはSSC洗浄)Agilent, GenePix2x11K, 22K, 

44KGE2-SSPE_91

(P/N G140-90050)

2色法遺伝子発現 v4.0.x
Agilent, GenePix2x11K, 22K, 

44KGE2-v4_91

(P/N G4140-90050)

2色法遺伝子発現 v5.0.x
（高密度フォーマット対応）Agilent, GenePix4x44K, 

2x105K, 244KGE2-v5_91_0806

遺伝子発現（2色法）

(P/N G4140-90040)

1色法遺伝子発現 v1.0.x
Agilent, GenePix2x11K, 22K, 

44KGE1-v1_91

(P/N G4140-90040)

1色法遺伝子発現 v5.0.x
（高密度フォーマット対応）Agilent, GenePix4x44K, 

2x105K, 244KGE1-v5_91_0806

遺伝子発現（1色法）

(P/N G4140-90010)

アレイCGH v4.0
Agilent, GenePix

2x11K, 22K, 
44K, 2x105K, 
244K

CGH-v4_91CGH

実験プロトコルスキャナ

Agilent
アレイ

フォーマット

FE Protocolアプリケーション


